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Spreadsheets constitute a powerful modeling tool and an easy computer programming language.
Spreadsheets' ubiquity, their low cost, their flexible programmable environment, as well as their
plotting capabilities, make them attractive as an educational tool. Their capability is illustrated
below through several examples ranging from classical control theory to more advanced topics such
as optimal control or state-observer. Some of these examples are developed as classroom activities,
whereas others are designed as interactive learning modules for illustrating specific control topics.
Our approach focuses exclusively on the standard use of spreadsheets; that is, no macros nor macro
language support are used. Pedagogical issues related to the use of spreadsheets in the classroom
are also discussed.
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INTRODUCTION

IN THE LAST FEW YEARS, spreadsheets have
become a popular computational tool and a
powerful platform for performing engineering
calculations. The simplicity of spreadsheet
programming, in addition to their rich library of
built-in functions, and plotting capabilities, have
made them attractive tools in many areas of en-
gineering and science [1, 2].

Spreadsheets are also used as a teaching tool to
construct computer demonstrations and labora-
tory simulations in many areas of engineering
education [3]. The combination of their flexible
programmable environment and their plotting
capabilities makes them powerful didactic tools.
Spreadsheets' ubiquity and their low cost
compared to professional software allow us to
consider them as an alternative tool for education.

The idea of using spreadsheets for control is not
new. Reference [4], which is one of the earliest
papers on this topic, illustrates a spreadsheet
implementation of a PID control of a DC-motor
model. The use of spreadsheets for teaching
process control was reported in [5], where the
numerical approach was adopted to solve the
differential equations of open and closed loop
systems. It is also worth mentioning reference [6],
which describes work where spreadsheets were
used for designing a graphical tool to simulate
linear systems. This tool was also extended to
simulate discrete systems [7], and non lineal
systems [8]. Thus, many people might be surprised
to discover that spreadsheets can be used for
control systems. However, all of the above-
mentioned works did not pay attention to techni-

ques inherent in state space representation, or to
how to exploit Excel-Solver utility to tackle opti-
mization problems, and neither did they consider
spreadsheets for designing interactive modules to
illustrate specific control concepts.

Below I shall discuss how to use spreadsheets for
control education through examples ranging from
classical control theory to more advanced topics,
such as optimal control or state-observer, as well
as how to design simple interactive modules.
Unlike the works [9, 10], where the author used
Excel spreadsheets in conjunction with Visual
Basic for Application (VBA) macro language to
develop a command-oriented control toolbox for
control system analysis and design, and to design
interactive modules for control education for the
Microsoft Excel environment, the here I focus
exclusively on the standard use of spreadsheets;
that is, entering data and formulae into worksheets
without the need for macro programming
language. This approach is effortless and particu-
larly suitable for students or instructors with no
programming background.

How do we use spreadsheets?
Our exploration of potential benefits in the use

of spreadsheets for control education began in
2004, aiming their use at reducing mathematical
manipulation during exercises in an introductory
course in control. Later, in 2006, we exploited the
spreadsheets' interactivity to develop some inter-
active learning modules to supplement lectures.

In the context of problem-solving activities,
students are traditionally exposed to analytical
techniques for plotting time and frequency
responses of linear systems, analyzing their stabi-
lity, or performing calculations for tuning control-
ler parameters, to mention only a few examples.* Accepted 2 April 2009
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The technique based on hand-driven calculations is
easy to carry out with simple systems, but requires
more mathematical manipulations when applied to
more complicated systems. Furthermore, this tech-
nique does not convey enough intuition to the
students, since they focus more on the mathema-
tical aspects rather than on control concepts.
Systems analysis can be confusing for students
because of its mathematical machinery rather
than its complexity. In this context, we used
spreadsheets to alleviate and simplify analytical
development. This approach is not really different
from analytical reasoning since students are still
thinking in terms of mathematical objects, but with
a substantial reduction in mathematical develop-
ment. Indeed, spreadsheets have all the suitable
tolls for performing control systems exercises. The
use of spreadsheets is simple and involves entering
appropriate formulae into worksheets, but requires
students to use care and creativity in order to get
the correct results.

On the other hand, an introductory course in
control exposes students to theoretical concepts
that are difficult to grasp quickly [11]. In such
circumstances, we designed some spreadsheet-
based interactive modules with animated graphs,
which are aimed at providing insight into the
fundamental concepts and present theoretical
concepts in a way that would help students to
develop good intuition for control fundamentals.
An interactive module is a collection of dynamical
graphics with active and clickable elements, which
is aimed at explaining a few concepts [12]. In
control education, many interactive tools have
been developed using specialized software, such
as Matlab in [13], Sysquake in [14], or JAVA
[15]. In the references [13, 14], ``the spreadsheet
metaphor'' is used to elucidate the interactivity
feature, where users can dynamically change para-
meters and immediately see their effects. Paradoxi-
cally, spreadsheet-based tools for control
education are practically non-existent, even
though programs such as Microsoft Excel provide
broad possibilities and an appropriate framework
for creating interactive learning modules.

In addition to the descriptions of the techniques
used to develop the examples, corresponding Excel
files can be downloaded from the web [16] so that
readers can study the details of the implementa-
tions. Even though the provided examples are
developed using Microsoft Excel, the modules
can be converted to any other spreadsheet
program with minor adaptations.

CLASSICAL CONTROL CONCEPTS

Time and frequency responses, stability analysis,
and feedback embody the fundamental ideas with
respect to continuous-time linear systems and
constitute the core of an introductory course in
control. Below we describe using simple examples
how spreadsheets can be used to plot frequency

responses, such as Bode and Nyquist diagrams,
plot time responses of linear systems to common
input signals, such as impulse, step, ramp, or
sinusoid, perform stability analysis using the
Routh-Hurwitz criterion, and how to perform a
simulation of a closed-loop control system.

Frequency response
Frequency response, such as Bode and Nyquist

diagrams, basically requires calculations with loga-
rithms and complex numbers. These types of
calculation can be performed easily using functions
provided by the Analysis ToolPack Add-in. This
tool should be activated in (Tools->Add-Ins->
Analysis ToolPak) menu. To illustrate the use of
these functions, let us consider a second-order
system given by the transfer function

G�s� � b1s� b2

s2 � a1s� a2
�1�

To obtain Bode and Nyquist diagrams, first, some
cells are reserved for entering the parameters of the
model, and two parameters (let us say n1 and n2)
are used to specify the frequency range (10±n1 to1
10n2). Next, a column with representative frequen-
cies evenly spaced along a logarithmic scale
between 10±d1 and 10d2 is created. A companion
column containing complex numbers s � j! is also
created using the COMPLEX function. After-
wards, the transfer function is evaluated as
complex number G� j!� by entering its corres-
ponding formula. Complex numbers are text
entries with the rectangular form (a� bi). The
real and imaginary parts, the module, and the
phase of complex numbers are obtained using
IMREAL, IMAGINARY, IMABS, and IMAR-
GUMENT functions, respectively. Finally, Bode
and Nyquist plots can be generated using the
standard Excel charting facility. Figure 1 shows a
screenshot of the implementation of this example.

Many formulae of the examples provided in this
paper use the naming cell, which is a mechanism
that allows the assignment of meaningful names to
cells. These names can be used as references, rather
than cell addresses, in formulae. The naming
mechanism is one of Excel's most valuable
features, and helps to improve the readability of
formulae and design well-organized worksheets.
The Excel naming tool is accessed from the
(Insert->Name->Create) menu.

Time response
Simulation of continuous-time systems is also

straightforward. The approach consists in trans-
forming continuous transfer functions to discrete
ones by using one of the many approximation
methods that map the s-domain into z-domain,
such as Euler's or Tustin's methods [17]. This
technique is systematic, and does not burden
students with numerical issues for solving ordinary
differential equations, since it does not require a
lot of mathematical machinery.
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For example, the discrete system that approx-
imates the system given in (1), using Euler's
forward approximation, is achieved through the
substitution given by s � �zÿ 1�=T , where T is the
sampling period. The substitution leads to the
following discrete transfer function,

Y�z�
E�z� �

d1zÿ1 � d2zÿ2

1� c1zÿ1 � c2zÿ2
�2�

where

c1 � a1T ÿ 2; c2 � 1ÿ a1T � a2T2

d1 � b1T ; d2 � b2T2 ÿ b1T

It is also worth mentioning that the variable z

arises strictly in the context of systems simulation.
The z-transform is introduced in the simplest
manner possible, limiting the explanation to z±1

being a notation that represents one step time
delay. Ultimately, the difference equation for
implementation purpose is

y�k� � d1e�k ÿ 1� � d2e�k ÿ 2�
ÿ c1y�k ÿ 1� ÿ c2y�k ÿ 2� �3�

This recursive equation can be easily implemented
using spreadsheets. The scheme works very well
if the sampling interval is small enough. Figure 2
shows the step and ramp responses of a second-
order system.

The method explained below can be easily

Fig. 1. Bode and Nyquist diagrams of a second-order system.

Fig. 2. Step and ramp responses of second-order system.
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extended to simulate parallel and series connec-
tions of linear systems. This possibility is particu-
larly appealing since it helps students to simulate
the effect of adding poles and zeros.

Routh-Hurwitz stability criterion
The Routh-Hurwitz stability criterion is a

method for determining whether a linear system
is stable or not by examining the locations of the
roots of the characteristic equation of the system.
The criterion establishes a systematic way for
determining whether any of the poles of any size
polynomial lie in the right half of the plane without
having to explicitly work out the poles. The
method is tabular and consists in building a table
from the coefficients of the polynomial

P�s� � ansn � anÿ1snÿ1 � � � � � a1s� a0

The table has �n� 1� rows with the following
structure

an an±2 an±4 ...
an±1 an±3 an±5 ...
b1 b2 b3 ...
c1 c2 c3 ...
... ... ... ...

where the elements bi and ci can be computed as
follows:

bi � anÿ1anÿ2i ÿ ananÿ2iÿ1

anÿ1
;

ci � b1anÿ2iÿ1 ÿ bi�1anÿ1

b1

i � 1; 2; ::; n

When completed, the number of sign changes in
the first column will be the number of non-negative
poles. This method is suitable for spreadsheet
implementation (see Figure 3).

The special case when the first element of a row
is zero can be handled also correctly. In this case,
the zero element is replaced by a small value (let us
say 0.0001), and then, the results are interpreted
assuming that this small number has the same sign
as the element above it. This method may also be
used to establish the limiting values for a variable
parameter, beyond which a system would become
unstable. In this case, these variable parameters
can be changed causing new results to take place
immediately.

Feedback and PID control
PID controller is of special interest in the study

of feedback control systems. In fact, it is an
unavoidable chapter in a basic control course.

Fig. 3. Implementation of Ruth-Hurwitz criteria.

Fig. 4. PID control of second-order continuous system.
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Here it is intended to show a spreadsheet imple-
mentation of feedback using such a controller. The
transfer function of a standard PID controller is
given by

C�s� � U�s�
E�s� � Kp � Ki

s
� Kds

1� Kds=N
�4�

where u�t� is the control signal, e�t� is the input,
and Kp, Ki, and Kd are the tuning parameters.

Again, applying Euler's approximation yields
the following difference equation:

u�n� � a0e�n� � a1e�nÿ 1� � a2e�nÿ 2�
ÿ b1u�nÿ 1� ÿ b2u�nÿ 2� �5�

with

a0 � �kpNT � kpkd � kiNT2 � kikdT � kdN�=
�NT � kd�

a1 � ÿ �2kdN � kdNT � 2kdkd � kikdT�=
�NT � kd�

a2 � �kpkd � kdN�=�NT � kd�
b1 � ÿ �NT � 2kd�=�NT � kd�
b2 � kd=�NT � kd�

T is the sampling period.
Equations in (5) can be easily programmed in a

spreadsheet. A simulation of PID control of a
second-order continuous system is illustrated in
Figure 4.

STATE-SPACE REPRESENTATION

State-space representation, also known as the
``time-domain approach'', provides a convenient
and compact way to model and analyze SISO and
MIMO systems. State-space representation is
particularly suitable for numerical computations,
and many calculations are carried out through
pure matrix algebra.

Unbeknown to many users, Excel can do matrix
operations very efficiently through its built-in
matrix functions, allowing us to handle state-
space calculations in a straightforward manner.
In Excel, some matrix operations use standard
operators (�, ÿ, *), while others require the use
of matrix functions such as MMULT, TRANS-
POSE, SUMPRODUCT, or MINVERSE. Matrix
formulae return results that can be a matrix, a
vector, or a scalar, and an area of the correct size
must be selected before entering the formula. After
typing the formula, the results are displayed by
pressing the three keys (Ctrl-Shift-Enter) at once.

Simulating systems given in state-space repre-
sentation consists in, once again, transforming the
continuous system to a discrete one. Applying

Tustin's approximation to multi-variable linear
systems given by

_x�t� � Acx�t� � Bcu�t�
y�t� � Cx�t� �Du�t�

�6�

yields a discretized system of the form [18]

xk�1 � Axk � B1uk�1 � B0uk

yk � Cxk �Duk �7�
with

A � I ÿ Ac
T

2

� �ÿ1

I � Ac
T

2

� �
;

B1 � B0 � I ÿ Ac
T

2

� �ÿ1
T

2
Bc;

I is the identity matrix, and T the sampling period.
The system given in (7) is simply a set of

difference equations that can be easily implemen-
ted using spreadsheet method. Indeed, spread-
sheets provide an appropriate framework to
work with state-space representation. Many
control concepts, such as state-variable feedback,
testing controllability and observability, or simula-
tion of multi-variable systems can be performed in
a straightforward manner. We take this one stage
further by presenting two examples developed as
classroom activities: the first deals with the design
pole-placement feedback technique using Acker-
mann's formula, the second shows how to use the
Excel Solver utility to tackle optimal control
strategy. Later, an interactive module illustrating
the state estimation concept (Luenberger observer)
is also provided.

Pole placement and Ackermann's formula
State-space design based on the pole-placement

method entails finding a state-variable feedback
gain so that the closed-loop poles are located at
desired locations. There are many techniques to
find a suitable state-variable feedback, as long as
the system is reachable. One such technique is
Ackermann's formula. If we consider the system
given in (6) with the state feedback, u � ÿKx, and
the desired closed-loop poles locations yielding a
characteristic polynomial P(s), then the state feed-
back is given by

K � EUÿ1P�Ac� �8�
where E � �0 � � � 0 1�; U � �B AB � � �� is the reach-
ability matrix, and P�s� is the desired characteristic
polynomial evaluated at the matrix Ac.

This design technique is a pure matrix calcula-
tion and can be implemented using spreadsheets.
Figure 5 shows a state-variable feedback using
Ackermann's method.

The interactive capacity of spreadsheets makes
easy to test different aspects, such as changing the
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poles' locations, or modifying the system para-
meters, and so forth.

Optimal control
Optimal control is a design technique that seeks

to optimize a given criteria (a performance index),
which is a quantitative measure of the quality of
the applied control. For example, find the best
possible tuning parameters of a controller that
minimizes some specified performance index, so
as to obtain minimum control energy expenditure,

minimum rise time, or some similar criteria.
However, obtaining this optimal adjustment is a
non-trivial task, which is often a result of heavy
mathematical analysis.

In the Excel environment, optimal control can
be tackled using the Solver tool [19]. Solver is a free
add-in to Excel that implements the generalized
reduced gradient non-linear optimization method,
and provides a convenient way to solve a variety of
optimization problems numerically. It is intuitive
and easy to use, since it provides an integrated

Fig. 5. Implementation of pole-placement feedback using Ackermann's formula.

Fig. 6. Optimal control using Solver utility.
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framework for problem setting. Its use could
represent a valuable tool to introduce students to
optimal control without a full understanding of the
underlying mathematics and without the need for
mastering advanced programming techniques.
Figure 6 shows a simulation using the solver to
find the optimal state-variable feedback gains of a
second-order system that minimizes the integral
squared error (ISE) index,

J � min

Z1
0

e2dt �9�

and that requires the control to satisfy the
constraint u�t�j j � 5.

In the ensuing solver dialog box, we first enter the
objective function (the ISE index) that is to be
minimized in the target cell. This cell contains the
SUM.SQUARE formula calculating the squared
errors of the error column. Second, the adjustable
cells (feedback gains) are also indicated, which could
have initial values. Finally, it is also possible to
impose constraints on variables, such as control
signal. The constraints in this example are,
$B$6:$B$30 <� 5 and $B$6:$B$30 >� ÿ5, and
define the control signal saturation limits. Upon
completing the execution of the algorithms, Excel
presentstheuserwiththeoptimaltuningparameters.

Solver is suitable for tackling many other
problems of optimization in an intuitive way. Its
use allows students to gain a better understanding
of the qualitative aspects of optimal control
concepts, and sets up a background for extensions
to other modern methods such as adaptive control,
model identification, and so forth.

INTERACTIVE LEARNING MODULES

Modern spreadsheets, such as Microsoft Excel,
provide utilities to create graphical user interfaces

(GUI's). Wrapping simulations, such ones devel-
oped throughout this paper, within a GUI, will
improve interactivity and would be advantageous
for teaching and learning. This feature allows users
to change parameters and view simulations with-
out having to deal with the values of cells. Indeed,
Excel includes a built-in tool with elements such as
sliders, radio buttons, check boxes, etc, which
allows developers to easily design GUIs for their
Excel applications. The reader can go even further
with Excel's help. As we point out below, Micro-
soft Excel provides broad possibilities for creating
interactive learning modules.

Time versus frequency domain
One of the properties of linear systems is that if

they are submitted to a sinusoidal input at a given
frequency, their outputs oscillate at the same
frequency, but the amplitude and the phase may
change. This property is generally difficult for
students to grasp quickly. This is a typical concept
that can be explained better with the help of an
interactive module. Figure 7 shows the screenshot
of our Excel construction developed for classroom
demonstrations.

This module implements a lag/lead filter
submitted to a sinusoidal input with an adjustable
frequency. The module plots Bode diagrams and
the time response to the corresponding sinusoidal
input. Users can vary the frequency from a slow to
a fast oscillatory input by just dragging a slider,
and immediately see the corresponding effect. The
amplitude ratio and the phase-shift are evaluated,
and can be checked immediately in the time
response.

The spreadsheet equations are wrapped within a
simple user interface, which is actually an Excel
worksheet. When using spreadsheets, there is no
need to design a specific input form, and the input
parameters of the simulation can be given through
reserved cells. A table is also reserved for holding
the spreadsheet formulae and the solutions.

Fig. 7. Time v. frequency response.
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Finally, plots of the simulation results are gener-
ated using standard Excel utilities.

Interactivity is driven, basically, using sliders.
Their use is straightforward and does not involve
programming of any kind. The insertion of a slider
into a worksheet is performed by selecting it from
the (View->Toolbars->Control) menu. After drag-
ging out an image, we have to set up the linked cell,
enter the maximum and the minimum values, and
the slider is ready for use. This feature makes it
easy to set up interactive Excel-driven simulations.

Min-Max and PID controllers
The PID controller is the most common solution

to practical control problems, and tuning it is one
of the most frequent design problems. Therefore, it
is appropriate to give it special attention. The
screenshot shown in Figure 8 below is another
interactive module that illustrates the PID and

Min-Max control of a continuous second-order
system. The module plots the system responses to
step input, as well as the control signal. The
interaction with the module is driven by sliders.
Students can explore a full range of parameters by
adjusting the values from low to high or vice versa.
At a first stage, students should get a feel for the
qualitative aspects of control, exploring what
happens if a given tuning parameter gain is
increased or decreased. The quantitative aspects
do not matter as much. This routine enables
students to quickly perceive the significance of a
closed loop, and ultimately understand the mean-
ing of the controller's tuning parameters better.

State observer
Simulations performed using state-space repre-

sentation can also be wrapped within interactive
user interfaces. As an example, Figure 9 below

Fig. 8. Min-Max and PID Control.

Fig. 9. Interactive state observer module.
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shows the screenshot of a module designed to
introduce the state observer concept to students.
The module simulates a second-order system, and
a full-state observer is used to estimate the state
variables of the systems. The system's initial condi-
tion as well as observer's poles can be changed
interactively using sliders. After dragging sliders,
all the graphics are updated in a coherent way,
reflecting the changes instantaneously. As the
observer is an approximate model of the system
(real plant), it is also appealing to investigate the
dynamic response of the observer when the model
parameters present some deviation from the real
plant.

DISCUSSION

The approach, based on Excel spreadsheet, was
used in an introductory course in control for two
consecutive academic years, from 2005±06 and
2006±07, at the Universidad Europea de Madrid.
The use of spreadsheets benefits students and
instructors in various respects.

The fact that the majority of students are famil-
iar with Microsoft Excel makes it convenient for
classroom activities. Some of these activities are
described throughout this paper, and can be
extended easily to different control topics. The
use of spreadsheets helps students to master analy-
tical techniques and proceed quickly. The reduc-
tion of the analytical developments allows students
to focus more on control concepts rather than on
programming, which ends up strengthening their
instruction. The inherent interactivity of spread-
sheets allows students to explore the effect of
varying parameters and easily experiment with
`̀ what-if '' scenarios.

Spreadsheets such as Microsoft Excel, provide
many utilities for designing interactive simulations,
and therefore can be used as an alternative plat-
form for developing educational tools. Educators
can become proficient in programming spread-
sheets in a matter of hours, and thereby design
their own classroom demonstrations. Interactive
simulations and effective applications can be devel-

oped in a reasonable amount of time. These
interactive modules are helpful in delivering
lectures by providing quick simulations, generating
multiple examples, and using them to reinforce the
study of many theoretical concepts. In this sense,
spreadsheets are not just a computational environ-
ment, but a valuable instrument for commun-
icating.

Furthermore, it is worth extending the use of
spreadsheets asking students to perform home-
work assignments designing specific modules sim-
ilar to the ones presented in this paper. The
incorporation of interactivity into the students'
assignments improves their engagement, and
designing attractive outputs helps them to
become involved in their own learning process.

From the students' point of view, an informal
focus group interview [20] conducted by the
instructor, revealed that the majority of students
consider that spreadsheet programs constitute a
convenient framework for developing control exer-
cises. They uniformly agreed that spreadsheets are
easy to use, and they especially do not add a
significant cognitive load. Furthermore, the inter-
activity and responsiveness of spreadsheets are
considered valuable features for learning, since
they allow students to observe the effect of varying
parameters on the system behaviors. In summary,
students believe that the use of spreadsheets is
effective in supplementing the course material.

CONCLUSIONS

This paper demonstrates how spreadsheets can
be used in control education. Examples of a broad
spectrum of topics, ranging from classical to
modern control theory, are provided. Interactive
tools with a good level of interactivity can also be
created with minimum effort. All of the examples
provided above have been developed making
standard use of spreadsheets. Spreadsheets'
ubiquity, their low cost, the convenience of their
graphical representations, and their high interac-
tivity allows us to consider them as an alternative
platform for control education.
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